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1 Introduction 

1.1 What is FoodCASE 

FoodCASE (Food Composition And System Environment) is a computerized food information 

management system that merges standardized rules and provide an environment for 

harmonized food composition data (FCD) compilation. 

It consists of two software applications – Compiler Client Module and Administration Tool. The 

former is utilised by compilers for FCD documentation and the latter allows setting properties 

and parameters applied for documentation and is only available for users with administrator 

rights. 

  

1.2 FoodCASE Administration Tool 

It is an extra software application of FoodCASE for setting properties and parameters applied for 

FCD documentation. The application is accessible only for compilers with administrator rights. 

Even the administrator himself does not have full rights to modify all settings, standard thesauri 

and other parameters. The database system available in the application is based on the 

European recommendations on food composition databases (Schlotke, et al., 2000; Becker, et 

al., 2007; Becker, et al., 2008; EuroFIR, 2013). 

 

 

 

2 About the Manual 

This manual gives instructions for managing systems, thesauri and quality parameters of FCD 

management system, FoodCASE. The manual is divided in several chapters based on the 

software layout. Particular steps of system management can be conducted arbitrary. Users can 

start work with each chapter independently on each other. 

 

 

3 Login and Exit 

3.1 Login 

For starting FoodCASE Administration Tool (hereinafter also application) user needs a personal 

user name and a password (Figure 3.1-1). The login data are case sensitive. As soon as the 

user is logged in, all operations (inputs or modifications) are recorded under the registered 

name.  

FoodCASE is a multi-user application, which means that multiple user can login at the same 

time. FoodCASE is also a client server system, which means that a user is working with a client 

application that is connected to the FoodCASE server, which is responsible for the data storage. 
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Figure 3.1-1 

If user name and/or password is not correct error message displays (Figure 3.1-2). Number of 

login attempts is not limited. 

 

 
Figure 3.1-2 

 

3.2 Exit 
To exit the application use one of the following: 

 Click the Menu File → Exit Ctrl+Q, 

 Use the Ctrl+Q keys, 

 Click the “x” sign in the upper right corner of the main screen. 
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4 Getting Started 

4.1 Graphic Controls 

The controls are listed from a major part in a chronological order based on usage of the 

application. 

 

 
Drop-down list – displays a list of available descriptors, 

columns, categories, properties or records and enables 

choosing one item from the list. 

 
Check/tick box – represents one of two values - “True” or 

“False”. Tick  in the check box field indicates “True”, 

which in most cases means that the operation is applicable 

for indicated record. 

    

  

    

Ascending/Descending Order – click on a header of any 

column sorts data in table in either ascending or descending 

order corresponding to the selected column. 

Note: Numbers are ordered first, then letters are ordered 

based on English alphabet and special letters (e.g. ä, š) are 

ordered in the end of the list. 

 
Confirm – confirms the process or action. 

 
Cancel – cancels selected option without any change. 

  
New – activates or displays empty rows for adding new 

record (i.e. descriptor, code, marker, condition, etc.). 

  
Edit – makes accessible details of selected record (row) for 

modification. 

 
Remove – removes record from the tab. 

 
Save – stores changes on data. 

 
Reload - reload of data 

 

Select from thesaurus/index, search in folder – opens 

standardized thesaurus, data table or folder and enables 

searching in it and select descriptor, record or file. 
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Radio button – only one option is allowed, it is applied for 

searching feature as an operator. 

 
Searched text – field for entering information that is 

searched.  

 
Create New Version – it creates a new version of the 

aggregated database, i.e. all data will be copied from the 

aggregated level into the new version. 

 
Mark Version for Publication – marks particular database 

version that is ready for publishing. 

 

Close – ends up work in detail window of a record and 

abandons it. If a particular record has been modified, a 

control question asking on saving changes or not precedes 

closing the window. 

 

Save – saves changes made on a record and leaves the 

detail window of the record open. 

 

Save and close - saves a change made on a record, ends 

up work in detail window of the record and abandons it. 

 
Run Quality Assessment… - launches the quality 

assessment based on defined parameters. 

 
Register Timer - opens a window for setting a period for 

automatic data quality assessment run. 

 
Cancel Timer – cancels timer set for a periodic data quality 

assessment run. 

 
Reschedule Timer – opens a window for resetting timer.  

 
Refresh – clears all search criteria and reloads actual data 

(e.g. just added or changed) from database. 
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4.2 General Functionalities of Main Registers 

4.2.1 Column Customisation  

The columns of each tab in the working area are customisable. One can move the displayed 

column to a desired place in the table by clicking on the head of the column and drag it to the 

desired position (Figure 4.2.1-1 and 4.2.1-2). Further, in the Versioning and Data Quality 

Analysis registers columns can be hidden (and displayed again) by right click on column head 

and using given options (Figure 4.2.1-3). 

For arranging columns to the default settings, close the application.  

 

 

Figure 4.2.1-1 

 

 

Figure 4.2.1-2 
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Figure 4.2.1-3 

 

4.2.2 Simple Copy and Paste Exporting 

Individual row can be copied to another application (e.g. Excel, Word) with Ctrl+C and Ctrl+V 

keys (Figures 4.2.2-1 and 4.2.2-2).  

 

 

Figure 4.2.2-1 

 

Figure 4.2.2-2 

 

4.2.3 Ascending/Descending Order 

Left click on the head of the column orders rows in ascending or descending way.  

Ordering is following: first are words beginning with special characters (e.g. “+”, “%”, “_”, “/”, “´”), 

numbers, second are words starting in English alphabet and special letters (e.g. ä, š) close the 

order. 
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4.2.4 Filtering Options in Data Quality Analysis Register 

Some columns contains drop-down arrow, which allows filter information in a table. Activation of 

drop-down list on column header shows filtering criteria specific to the column (Figure 4.2.4-1).  

Advanced filter can be set to an individual column by selecting “(Custom)” functionality and using 

Custom AutoFilter (Figure 4.2.4-2). 

 

 
Figure 4.2.4-1 

 

 

Figure 4.2.4-2: Filtered data based on given criteria in Custom AutoFilter 
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4.2.5 Colour Conventions and Indicators 

White fields – active text fields accessible for modification,  

Grey fields and texts– read-only, fields and buttons not accessible for modification or use. 

 

4.2.6 Working with Registers – Opening, Adding, Editing and Deleting 
 Record 
 

Modifications of descriptors are partially limited since Administration Tool contains standardized 

thesauri and coding systems that are generally recognized by European compiler organisations 

and their proper use is essential for data compatibility. Thus, arbitrary modification is undesirable 

and hence the modification of the EuroFIR thesauri are not allowed. All these thesauri are 

located in the “EuroFIR Thesauri” tab.  

Users with administrator rights are allowed to modify the General Settings, User Administration, 

User Thesauri, Versioning and Data Quality Analysis registers. 

 

Opening Record 

There are two possible ways for opening a record: 

 Single click on a record displays detail at the bottom of the tag (Figure 4.2.6-1). This is 

applicable in all registers except for Quality Assessment register. 

 Double click on a record or click on the Open button opens a detail window of a record. This 

is valid in the Quality Assessment register only. User can modify particular record in detail 

window (Figure 4.2.6-2). 
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Figure 4.2.6-1 

 

 

Figure 4.2.6-2 
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Adding New Record 

Adding a new record can be conducted in all registers except for EuroFIR Thesauri register by 

using the Add or New button. 

 

Editing Record 

There exist two possible ways for record modification: 

 Click on the Edit button makes record details accessible for modification (colour of the field 

turns to white colour) and click the Save (or Save and Close) button saves the modified 

information. 

 Modification of information in detail window of a record and click the Save (or Save and 

Close) button saves the modified information. 

 

Deleting Record 

Deletion is irreversible and can be done by clicking on the Delete button. Deletion is possible 

only for following registers:  

- User Administration 

- Quality Assessment Analysis  

Deletion must be confirmed by clicking on the Yes button (or the No button if deletion is not 

desired) (Figure 4.2.6-3). 

 

 

Figure 4.2.6-3 
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5 Main Application 

5.1 Main Screen 

The main screen of the application (Figure 5.1) has a very simple layout consisting of six main 

registers:  

 General Settings 

 User Administration (Figure 5.1) 

 EuroFIR Thesauri 

 User Thesauri 

 Versioning 

 Data Quality Analysis 

Some registers contain further sub-registers (tabs).  

When application is launched, user always sees the register which was open, when it was last 

closed. 

 

 

Figure 5.1 
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5.2 Menu Bar 

5.2.1 Menu File  

 

Exit Ctrl+Q 

Click the Menu File → Exit Ctrl+Q or use of the Ctrl+Q keys closes the application. 

 

5.2.2 Menu Help 

 

About… 

Menu Help → About is an information window about version of the application, copyright and 

owner (Figure 5.2.2). 

 

 
Figure 5.2.2 

 

 

 

6 Working with Registers 

6.1 General Settings 

6.1.1 Bug Tracking 

It displays the URL to the current BugTracker system (Figure 6.1.1-1). When compilers working 

in the Compiler Client application and want to report bugs, they will be directed to this URL when 

they click on Menu Tools → BugTracker. The BugTracker system is accessible for registered 

users only. 

 



User Manual for FoodCASE Administration Tool 1.4.5, draft 1, May 2013 

  

 
16 

 
Figure 6.1.1-1 

6.1.2 Look & Feel 

The tab enables selection of different colours and defining a title of the Compiler Client 

application (Figures 6.1.2-1 and 6.1.2-2). This helps users distinguish a productive environment 

from a test environment. If users have installed FoodCASE twice, once to test some data and 

functionality (test environment) and once for their productive data, these two settings help faster 

recognition if one is working in the test or productive environment. 
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Figure 6.1.2-1 
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Figure 6.1.2-2: Name of the environment and the coloured strip over the menu displays in  

 Compiler Client module 

 

 

6.2 User Administration 

The register is used for management of users of the application. There are two user roles 

created at present: 

 Admin [1] – has right to work with FoodCASE Administration Tool and may define and 

modify existing compilers for using FoodCASE Compiler Client module, 

 Compiler [2] – has an access to work with FoodCASE Compiler Client module. 

 

6.2.1 Adding New, Modifying and Deleting Existing User 

Admin can add new users and modify or delete existing users. 

 

Adding new user 

1.  Go to the User Administration register (Figure 5.1) 

2.  Click the New... button 

3.  Complete login name, name of a user and a password (default password is displayed) 

4.  Click the OK button to save the user (Figure 6.2.1-1) 
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Note: When creating a new user, the administrator defines the password, but the password will not be 

displayed in the table. The administrator is not able to see any passwords of any user after creating 

the account. 

 

 

Figure 6.2.1-1 

 

Modifying existing user  

1. Go to the User administration register (Figure 5.1) 

2. Set cursor on a user 

3. Click the Edit... button 

4. Edit login name, name of a user and add a password  

5. Click the OK button to save changes (Figure 6.2.1-2) 

 

Note: When a user forgets his/her password, the administrator cannot give it to him again but the 

administrator can overwrite the password, give this new password to the user. 
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Figure 6.2.1-2 

 

Deleting existing user 

For removing a user, set the cursor on desired user and click the Remove button. The user is 

immediately deleted from the list and losses all access rights for FoodCASE. 

 

 

6.3 EuroFIR Thesauri 

The register is used for viewing EuroFIR thesauri. There are following thesauri included: 

Components, Acquisition Types, Units, Matrix Units, Reference Types, Value Types, Method 

Types, Method Indicators and Component Groups (Figure 6.3).  

EuroFIR thesauri have common concept with following fields: code, descriptor, scope note, 

additional information, synonyms and related terms. Code and descriptor are mandatory, while 

other fields are optional and are useful for complementary and unambiguous description of a 

concept.  

Each thesaurus contains column “Id”, which contains database identifiers for listed descriptors 

and columns indicating who and when created and modified a record. 

Since EuroFIR thesauri are standardized vocabularies that are recognized by compiler 

organisations, they are not modifiable in FoodCASE.  
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Figure 6.3 
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6.3.1 Components 

It is a list of EuroFIR component identifiers with codes and recommended measure units. The 

tab includes space for recording complementary Chebi, Eurofoods and INFOODS component 

codes.  

Only values for components ticked for "Public" will be automatically exported for publishing, e.g. 

on a website (Figure 6.3.1). The thesaurus is in read-only mode. 

 

 
Figure 6.3.1 
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6.3.2 Acquisition Types 

It is a EuroFIR thesaurus of acquisition types for indication from where information was acquired 

(Figure 6.3.2). The thesaurus is in read-only mode. 

 

 
Figure 6.3.2 

 

6.3.3 Units 

It is a EuroFIR thesaurus of measure units with additional information and scope notes that 

enable users apply the descriptors properly for data documentation (aggregation and recipe 

calculation).  

In addition, the thesaurus includes overview of additional units added by compilers in the User 

Thesauri register (in the Units tab) (Figure 6.3.3).  

The columns “Is For Value” and “Is For Cooking” indicates level at which unit can be applied. 

Application for value means that unit can be used for expression of component content. 

Application for cooking means that unit can be used for defining amounts of ingredients in recipe 

calculation.  

The last column entitled “Editable” indicates which units are default (defined by EuroFIR) and 

which are added by compilers themselves. User can not remove or add tick to an EuroFIR unit. 

Units added by compilers can be set either accessible for modification or blocked. Tick in the 

field means that the unit is modifiable. Editable units can be modified in User Thesauri register. 

Changes can be seen after closing and reopening the application. 

However, this tab is in read-only mode. 
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Figure 6.3.3: Users added own descriptors – highlighted in red rectangle 
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6.3.4 Matrix Units 

It is a EuroFIR thesaurus of matrix units, which is used to express mass quantity for which 

composition is given.  

Tick in the field of the column “For aggregation” indicates in which matrix, foods, which are going 

to be aggregated, may be expressed (Figure 6.3.4). This tab is in read-only mode. 

 

 
Figure 6.3.4 
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6.3.5 Reference Types 

It is a EuroFIR thesaurus providing kinds of sources for food composition information (Figure 

6.3.5). This tab is in read-only mode. 

 

 
Figure 6.3.5 
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6.3.6 Value Types 

It is a EuroFIR thesaurus of value types, which represent character of component value (Figure 

6.3.6). This tab is in read-only mode. 

 

 
Figure 6.3.6 
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6.3.7 Method Types 

It is a EuroFIR thesaurus of method types, which indicates procedure, used for obtaining 

component value (Figure 6.3.7). This tab is in read-only mode. 

 

 
Figure 6.3.7  

 

6.3.8 Method Indicators 

It is a EuroFIR thesaurus of method indicators extended with user method indicators which help 

assign component value with particular analytical or calculation procedure.  

The column “Formula” contains a formula in a given syntax, so that FoodCASE is able to 

interpret this formula and calculate the value in the given unit. The column “Group” gives 

information to which component category (group) belongs component for which indicator is 

stated (Figure 6.3.8-1). The “Usage Notes” presents extra condition (information) for contributing 

components used in a formula (e.g. Figure 6.3.8-2).  
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Figure 6.3.8-1 

 

 

Figure 6.3.8-2 
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6.3.9 Component Groups 

It is a list of EuroFIR component groups. Column “Parent” indicates superior group (Figure 

6.3.9).  

 

 

Figure 6.3.9 

 

6.4 User Thesauri 

It is a register for additional thesauri. The title itself evokes that user can modify them by own. 

Those are Markers, Unit Conversions, Recipe Preparation Methods, Units and Method Indicator 

Defaults. 

 

6.4.1 Markers  

Markers are indexing terms used for food or component value identification. Here, in FoodCASE 

Administration Tool, they can be defined by user. The tab for markers is split into two sections. 

The left part is for single level database and the right is for the aggregated database (including 

recipes). Altogether, there are four entities for which markers can be defined: single food, single 

value, aggregated food (including recipes) and aggregated value (including values calculated as 

recipes) (Figure 6.4.1.1-1). These four entities are blocked for deletion. Each entity contains 

tree-structured groups of markers (e.g. main group – record status, subgroups – partial, 

checked, completed, deleted); however, it is up to users how they organise their markers. 
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6.4.1.1 Defining Markers 

1. Go to the User Thesauri register and select the Markers tab (Figure 6.4.1.1-1) 

2. By left click select a marker or marker group/sub-group to which you want add a new marker. 

Selected marker or group displays in the field Name (Figure 6.4.1.1-2) 

3. Click the Add button at the bottom of the particular section to add a new marker. The new 

item integrates into the selected marker group (Figure 6.4.1.1-3) 

4. Rename the “New Marker” as you desire in the text field Name and fill in description 

information if relevant (Figure 6.4.1.1-4) 

5. Click the Save button in the lower right corner to save new marker. As soon as the marker is 

saved, it can be immediately applied in FoodCASE Compiler Client module (Figure 6.4.1.1-

5), however if both applications are open at the same time, Compiler Client must be restarted 

to consider changes carried out in Administration Tool 

 

Note: Individual marker turns to group as soon as another tree level is created within this marker 

   (Figure 6.4.1.1-6) 
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Figure 6.4.1.1-1 
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Figure 6.4.1.1-2: Highlighted group displays in the field Name  
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Figure 6.4.1.1-3: New marker integrated into the marker group Special Dietary Food 
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Figure 6.4.1.1-4 
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Figure 6.4.1.1-5: New marker can be applied for indexing in Compiler Client module 

 

  

      Figure 6.4.1.1-6: Individual marker (“checked”) turns to group as soon as another tree level 

(“Proximates”) is created within this marker 
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6.4.1.2 Updating Markers  

Markers can be modified: 

 By left click on a marker and simple rewriting of name in the field Name, 

 By left click on a marker and moving it to a different position in the marker tree. Moving 

is possible between single and aggregated level as well.  

Any changes must be confirmed by the Save button.  

Be careful when modifying a marker, which is already used for data identification. 

 

Note: Any incidental or undesired modifications on markers and changes can be abolished with 

Cancel buttons, however the Cancel button is not more active after the Save button was used. 

There are Cancel buttons that are specific for single and aggregated sections and the Cancel 

button applicable for the whole tab (in the right lower corner of the tab). 

 

6.4.1.3 Deleting Markers  

Markers can be deleted by left click on a marker and using the Remove button. 

Any changes must be confirmed by the Save button.  

As soon as a marker is used for data identification, it cannot be deleted and the application 

notifies user by a message window about how many times it is used (Figure 6.4.1.3). 

 

 

Figure 6.4.1.3 
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Note: Any incidental or undesired deletion of markers can be abolished with Cancel buttons, 

however the Cancel button is not more active after the Save button was used. 

There are Cancel buttons that are specific solely for single and aggregated sections and the 

Cancel button applicable for the whole tab (in the right lower corner of the tab). 

 

 

6.4.2 Unit Conversions 

The Unit Conversions are useful for converting commonly applied household measures, like 

spoon, cup or egg into standard measure units. When defining a recipe compiler does not need 

to convert eggs into e.g. grams, just enters number of eggs and the application coverts it into 

standard measure unit, by using specific conversion factor defined by compiler.  

 

6.4.2.1 Defining New Unit Conversion 

Before a unit conversion is defined, user must add a source unit into the Units tab in the User 

Thesauri register (for more details and procedure see chapter 6.4.4 Units). 

 

Procedure 

1.   Go to the User Thesauri register and select the Unit Conversions tab (Figure 6.4.2.1-1) 

2. Click the New button to add a new row in the tab (Figure 6.4.2.1-2) 

3. Select source and target units from the drop down lists and define conversion multiplier     

 between these units at the bottom of the window 

4. Click the Save button to store the new conversion (Compiler Client module must be restarted 

to update units conversion) (Figure 6.4.2.1-3) 

 

Note: Conversions must be defined carefully, in order they work properly (e.g. spoon converted 

into grams is not a precise conversion, because foods have different density and spoon 

different size, more detailed specification is e.g. teaspoon of honey, tablespoon of flour). 
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Figure 6.4.2.1-1 

 
 

 
Figure 6.4.2.1-2 
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Figure 6.4.2.1-3 

 

6.4.2.2 Updating Unit Conversion 

1.   Go to the User Thesauri register and select the Unit Conversions tab (Figure 6.4.2.2-1) 

2. Left click on an item and click the Edit button to activate the item for modification 

3. Change source and/or target units available in the drop down lists and/or define conversion 

multiplier between these units (Figure 6.4.2.2-2) 

4. Click the Save button to store updated information (Compiler Client module must be 

restarted to update units conversion) (Figure 6.4.2.2-3) 
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Figure 6.4.2.2-1 

 

 
Figure 6.4.2.2-2 
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Figure 6.4.2.2-3 

 

 

6.4.3 Recipe Preparation Methods 

Recipe Preparation Methods tab (Figure 6.4.3) includes list of cooking methods that can be 

applied for recipe calculation in Compiler Client.  

Here, in Administration Tool user can modify cooking methods. In addition to standardized 

EuroFIR methods, which are based on facet G in LanguaL, user, can add own cooking methods 

and its description.  

Cooking methods are connected with retention factors and thus when a method is selected; 

particular retention factors are applied for component values of ingredients during recipe 

calculation.  

Note: Each food must be correctly classified in the Aggregated food detail window before it is 

selected for recipe calculation because retention factors are dependent on the cooking method 

and on the EuroFIR food classification. 
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Figure 6.4.3 

 

6.4.3.1 Defining New Cooking Method  

1. Go to the User Thesauri register and select the Recipe Preparation Methods tab (Figure 

6.4.3) 

2. Click the New button to add a new row in the tab (Figure 6.4.3) 

3. Fill in name and description of a cooking method  

4. Click the Save button to save the new cooking method (Compiler Client module must be 

restarted to update list of cooking methods) 

 

 

6.4.3.2 Updating Cooking Method  

1. Go to the User Thesauri register and select the Recipe Preparation Methods tab (Figure 

6.4.3) 

2. Left click on an item and click the Edit button to activate the item for modification 

3. Change the cooking method (Figure 6.4.3.2) 

4. Click the Save button to save the change on the cooking method (Compiler Client module 

must be restarted to update list of cooking methods) 
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Figure 6.4.3.2 

 

 

6.4.4 Units 

This tab is used for defining own measure units. It can be either rare measure unit (e.g. 

centilitres) or household measure (e.g. spoon, cup of tea) (Figure 6.4.4). Subsequently one can 

use Unit Conversions tab to define conversion factor between specific unit and EuroFIR 

standardized measure units (see chapter 6.4.2 Unit Conversions). 
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Figure 6.4.4 

 

6.4.4.1 Defining New Unit  

1. Go to the User Thesauri register and select the Unit tab (Figure 6.4.4) 

2. Click the New button to add a new row in the tab (Figure 6.4.4.1-1) 

3. Define new unit and specify for what purpose it will be applied (for value and/or for cooking) 

(Figure 6.4.4.1-2) 

4. Click the Save button to save the new unit (Compiler Client must be restarted to update list 

of units) (Figure 6.4.4.1-3)  
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Figure 6.4.4.1-1 

 

 
Figure 6.4.4.1-2 



User Manual for FoodCASE Administration Tool 1.4.5, draft 1, May 2013 

  

 
47 

 
Figure 6.4.4.1-3  

 
 

6.4.4.2 Updating Unit  

1. Go to the User Thesauri register and select the Units tab (Figure 6.4.4) 

2. Left click on an item and click the Edit button to activate the item for modification 

3. Change the unit (Figure 6.4.4.2-1) 

4. Click the Save button to store the change (Compiler Client must be restarted to update list of 

units) (Figure 6.4.4.2-2) 
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Figure 6.4.4.2-1 

 

 

Figure 6.4.4.2-2 
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6.4.5 Method Indicator Defaults 

For some calculated components, there exist two or more calculating methods in EuroFIR 

Method Indicator Thesaurus. In this tab, user can set default calculating method for calculated 

components (Figure 6.4.5) and then preferred method is applied for calculation in Compiler 

Client and user does not have to select it individually. Even though user set a default method, 

still there will be possibility to change to another method indicator in the Compiler Client if 

needed. 

 

 
Figure 6.4.5: Comment: The available buttons are not active. 

 

6.4.6 Own Coding System  

In the Compiler Client application, there is actually incorporated the Swiss food group 

categorisation. However, this categorisation, claimed as a user categorisation, is without any 

possible way for modification. Here, in Admin Tool could be added another tab for “Own food 

group coding system”, e.g. for national standard, that could be created through Administration 

Tool and applied in Compiler Client as a local-specific standard. 
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6.5 Versioning 

The register Versioning gives an overview of archived database versions of aggregated 

FoodCASE database. The head database version is the one on which compilers always work. 

All others are snapshots of the head version created at a specific time (Figure 6.5).  

If the head version is marked for public (e.g. for a website), then all changes will be published 

immediately whenever something in the database has changed. 

 

 
Figure 6.5: Here two versions of the database are available - the “head” version is marked for 

publishing 

 

6.5.1 Creating New Database Version 

New database version is a snapshot of the head version at a specific time. The new version is 

stored in the archive and is available only for reading. Compilers continue working on the head 

version. 

 

Procedure 

1.  Go to the Versioning register 

2.  Tick the check box I am sure I want to do this to confirm that and thus confirm that a new 

version wants to be created (Figure 6.5.1-1) 

3.  Enter name of a new version into the text field Version name  

4.  Click the Create New Version button and new version is created after a while (Figure 6.5.1-

2). The newly created version can be seen in drop down window of the Version register in 

FoodCASE Compiler Client  

 

Note: Name of the version in the field “Text” can include own numbering, naming and dates.  
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Figure 6.5.1-1 

 

 

Figure 6.5.1-2 
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6.5.2 Numbering the Database Versions 

Database numbers of versions are assigned automatically by software.  

Following principle is applied for numbering different database versions: 

1 - Current version, 

2 - First archived version, which is oldest version, 

3 – Second archived version, which is the second oldest version 

…  

n – The latest archived version available 

 

Anytime a new version of the database is created in the Versioning register, it is identified with 

number following chronologically (n+1). 

  

6.5.3 Marking Version for Publishing 

Any version on the list can be marked for publication by setting cursor on a version and click the 

Mark Version for Publication button (or by putting a tick in the check box). This version is 

marked as the public version. This mark can for instance, be used to show only this data on a 

website. 

 

 

 

6.6 Data Quality Analysis  

This register is used for setting qualitative parameters and frequency of data quality assessment. 

Assessment can be run only in FoodCASE Administration Tool over the current version. There 

are six tabs within this register.  

 

6.6.1 General Principles 

For quality assessment purposes there are applied various principles in FoodCASE that are on 

the cutting research edge in the area of data quality. As data quality is quite complex topic, 

FoodCASE offers maximum flexibility for the definition of quality measurement. In order, it is 

necessary that to use SQL-like syntax to define some of the measurement parameters. These 

functionalities are described in the following.  

 

6.6.2 Quality Entities  

This is a list of standard entities in FoodCASE (Figure 6.6.2-1). Quality entities are used to 

define on what business object is quality assessed. The list of quality entities is complete so that 

no entities must be added. Anyway, to modify a quality entity, it is helpful to understand the 

database structure of FoodCASE. 
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Figure 6.6.2-1: Based on defined condition quality assessment is conducted on the latest 

(actual) database at aggregated food, aggregated component, recipe level and at 

the “test entity”. Quality assessment is not conducted on the references and on 

the single database level 

 
 

 

Figure 6.6.2-2: Entities can be modified by use of the Open, New and Delete buttons 
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6.6.3 Quality Entity Filter 

It is a table for defining terms for filtering data according to various descriptors when setting 

criteria for quality assessment analysis. For example, aggregated components can be filtered 

based on the Method Indicator thesaurus (Figure 6.6.3-1). These filter parameters can be 

subsequently seen in Data Quality Analysis Toolkit which is accessible via Compiler Client 

(Figure 6.6.3-2). Standard buttons Open, New, Delete and Refresh are used for setting filter 

parameters to an entity. 

 

 
Figure 6.6.3-1 
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Figure 6.6.3-2 

 

 

Quality Entity Filter Details 

When setting quality entity filter (Figure 6.6.3-1), all information that can be defined in an SQL 

statement can be defined. 

 

6.6.4 Quality Requirements 

Here user defines measures for quality assessment. For instance, measure that check data 

consistency for sum of all components in food to give 100 (Figure 6.6.4-1 and 6.6.4-2). For 

adding, deleting and editing requirements use standard buttons Open, New, Delete and 

Refresh. However, the requirement is described by SQL language and that is why an IT 

specialist must specify it. 
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Figure 6.6.4-1 

 

 

 

Figure 6.6.4-2 
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Quality Requirement Details 

When defining new measure for quality assessment (Figure 6.6.4-2), following information needs 

to be defined: 

Entity – select it from the drop down window of the existing entities (entities can be modified in 

Quality Entities tab),  

Name – enter name of measure, 

Description – describe in details conditions of measure  

Type – define if the requirement is a hard constraint, soft constraint or an indicator, 

Assessment SQL – measurement of data quality requirement written in SQL-like manner. 

 

 

6.6.5 Quality Assessment 

Executed runs of quality assessment are listed here. The tab indicates who and when carried 

out the quality assessment (Figure 6.6.5-1). The name of the run can be modified using the 

Open button (Figure 6.6.5-2) or run can be deleted completely from the database by using the 

Delete button. Click on the New button redirects user to the Run Quality Assessment tab. 

 

 

Figure 6.6.5-1 
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Figure 6.6.5-2 

 

6.6.6 Run Quality Assessment 

Here user can launch the quality assessment based on defined parameters. 

The run takes quite long time and length depends on size of database and number of quality 

requirements set for data.  

The progress of the analysis is indicated by the green line and by per cent of achieved checks. 

At the same time, particular requirements with number of hits on how many records met the 

requirement are displaying continually (Figure 6.6.6-2).  

There is no special button to stop running of the quality assessment, however, by closing the 

application the analysis stops (Figure 6.6.6-4).  

Before quality assessment is launched, user should define conditions under which analysis will 

run (e.g. entities, database versions, quality conditions, etc.; see chap. 6.6.1 - 6.6.5).  

 

Procedure  

1. Go to the Run Quality Assessment tab and click the Run Quality Assessment button  

2. Enter a name of the run and click the OK button (Figure 6.6.6-1) 

3. The application starts analysis (which might take several minutes or even half an hour) 

(Figure 6.6.6-2) 
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4. As soon as the assessment is done (Figure 6.6.6-3), user can see the results in the Data 

Quality Analysis Toolkit in the Compiler Client of FoodCASE (Menu File → View → Data 

Quality Analysis (new) → Select a quality assessment) and analyse them  

 

 Note:  For a large database, it might be best to start a quality assessment at the end of the 

     day and let it run over night. 

 

 
Figure 6.6.6-1 
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Figure 6.6.6-2 

 

 

Figure 6.6.6-3 
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Figure 6.6.6-4 

 
 

6.6.7 Quality Assessment Timer 

In FoodCASE Administration Tool periodicity of the assessment can be set by timer to be carried 

out regularly. When timer is set, analysis can run automatically without need to start up any of 

the applications. That means that while only administrator is authorized to set parameters and 

timer to run the analysis, the results of the assessment can be whenever analysed by compilers 

in Data Quality Analysis Toolkit.  

 

Procedure for setting/cancelling/resetting timer 

1. Go to the Quality Assessment Timer tab (Figure 6.6.7-1) 

2. Click the Register Timer button 

3. Define start time and interval for regular run of analysis (Figure 6.6.7-2) and click the 

Save (or Save and Close) button 

4. Timer can be cancelled or rescheduled by using the Cancel Timer and the Reschedule 

Timer buttons, respectively (Figure 6.6.7-3) 

 

Note: The timer can launch the earliest run shortly after midnight of the actual date. The shortest 

frequency for running the analysis is 1 day.  
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Figure 6.6.7-1 

 

 
Figure 6.6.7-2 
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Figure 6.6.7-3 

 

 

7  FoodCASE Administration Tool vs. Compiler Client Application 

There is no limitation for working on both applications at the same time; however, changes 

conducted in Administration Tool are not applied in FoodCASE Compiler Client unless Compiler 

Client is restarted.  
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